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Résumé  

Ces dernières années, le nombre de communications cellulaires a connu une croissance exponentielle. 

Ce dernier a bénéficié de l'amélioration des composants électroniques permettant aux terminaux 

portables de rester compacts. Les diverses applications des dispositifs de communication nécessitent 

des fréquences de fonctionnement distinctes. En fonction des exigences de conception, la géométrie 

des antennes microruban peut être ajustée pour résonner à plusieurs fréquences. Dans ce mémoire, 

nous proposons la conception d'une antenne rectangulaire microruban à fentes à l'aide d'une technique 

d'alimentation par sonde coaxiale. Le concept de conception consiste à incorporer des fentes dans le 

patch rayonnant d'une antenne patch microstrip conventionnelle de 5,5 GHz afin de créer trois bandes 

de fréquences.  Deux géométries de fentes sont insérées, une fente rectangulaire et une fente de forme 

8. Les positions et les dimensions des fentes sont déterminées à l'aide d'une analyse paramétrique pour 

atteindre les objectifs requis.  

Mots clés: Antenne patch, tri-bande, fentes, miniaturisation. 

Abstract 

In recent years, the number of cellular communications has grown exponentially. This latter has 

benefited from the improvement of electronic components allowing portable terminals to remain 

compact. Variety of applications in communication devices require separate operating frequencies. 

Depending on the design requirement, microstrip antennas geometry can be adjusted to resonate at 

multiple frequencies. In this work we propose a design of a triple-band microstrip rectangular antenna 

with slots using coaxial probe-feed technique. The design concept is to incorporate slots into the 

radiating patch of a conventional 5.5 GHz microstrip patch antenna in order to create three frequency 

bands. Two slot geometries are inserted, a rectangular slot and an 8-shape slot. The positions and 

dimensions of the slots are determined using parametric analysis to achieve the required objectives. 

 

 Keywords: Patch antenna, tri-band, slots, miniaturization. 

 ملخص

في السنوات الأخيرة تطورت الاتصالات الخلوية بشكل كبير. وقد استفادت هذه الأخيرة من تحسين المكونات الإلكترونية التي تسمح 

للمحطات المحمولة بأن تظل مدمجة ، تتطلب التطبيقات المختلفة لأجهزة الاتصالات ترددات تشغيل منفصلة. اعتمادا على متطلبات 

في هذه الأطروحة ، نقترح تصميم  التصميم ، يمكن ضبط هندسة هوائيات الشريط الصغير بحيث يتردد صداها على ترددات متعددة

هوائي ميكروريبون مستطيل الشكل مع فتحات باستخدام تقنية تغذية مسبار محوري. يتمثل مفهوم التصميم في دمج الفتحات في 

جيجا هرتز لإنشاء ثلاثة نطاقات تردد يتم إدخال فتحتين هندسيتين، فتحة  5.5تريب التقليدي التصحيح المشع لهوائي تصحيح ميكروس

. يتم تحديد مواضع وأبعاد الفتحات باستخدام التحليل البارامتري لتحقيق الأهداف المطلوبة.8مستطيلة وشق على شكل   

تصغير.: هوائي التصحيح ، النطاق الثلاثي ، الفتحات ، الالكلمات المفتاحية  
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Introduction générale 

Le développement rapide des systèmes de communication sans fil ont conduit à de 

nombreuses améliorations au niveau des dispositifs et des systèmes sans fil pour 

répondre aux exigences des applications multimédia. L’antenne est l’un de ces 

dispositifs qui joue un rôle important dans l’amélioration des performances des 

systèmes. une antenne est un dispositif permettant de rayonner (émetteur) ou de capter 

(récepteur) les ondes électromagnétiques. L'antenne est un élément fondamental dans un 

système radioélectrique[1]. 

 

Il existe plusieurs types d’antennes telles que les antennes paraboliques, les antennes 

patchs, les antennes Yagi, les antennes dipôles, etc. L’antenne patch ou micro ruban est 

l'une des antennes les plus utilisées dans les communications sans fil. Elle est destinée à 

de nombreuses applications dans différents domaines tels que les communications par 

réseau local sans fil (WLAN), les communications par satellite, les récepteurs radar et 

elle peuvent être utilisées dans d’autres produits sans fil [2]. 

Les antennes micro-rubans sont très populaires en raison de leurs caractéristiques telles 

que la taille réduite, la facilité d’intégration, le faible poids, la fabrication à faible coût, 

etc. Dans un autre côté, ces antennes imposent divers inconvénients, tels qu'une bande 

passante étroite, un gain faible et faible rendement . À ce jour, des recherches sont en 

cours pour réduire ces inconvénients. 

Actuellement, la multiplication et la diversité des standards de communications radio-

mobiles tels que : GSM, DCS, UMTS, WLAN, Bluetooth, TV Numérique,…..etc. ont 

créé un besoin pressant pour des antennes compactes multifréquences et/ou large bande 

permettant notamment d’assurer la compatibilité des différentes normes ou accéder à de 

nombreux services à partir du même appareil ce qui incité les chercheurs à trouver des 

modèles d'antennes de plus en plus complexes faisant généralement appel à des 

structures court-circuitées ou avec des fentes rayonnantes qui permettent d’abaisser les 

modes supérieurs. Nous définissons une "fente" comme une ouverture découpée dans 

une surface conductrice métallique obligeant les courants de surface à allonger leur trajet 

pour la contourner. L’insertion de fente dans l’élément rayonnant constitue une solution 

intéressante pour la réduction de taille des antennes. 

Lorsque les courants circuleront sur l’élément rayonnant, l’insertion d’une fente pourra 

créer de nouvelles résonances. Le choix de la forme et de la longueur de ces fentes 

https://fr.wikipedia.org/wiki/%C3%89metteur_d%27ondes_radio%C3%A9lectriques
https://fr.wikipedia.org/wiki/R%C3%A9cepteur_radio
https://fr.wikipedia.org/wiki/Onde_%C3%A9lectromagn%C3%A9tique
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détermineront les fréquences de fonctionnement de l’antenne et les impédances 

d’entrée[3]. 

L’objectif de ce mémoire est la Conception et simulation d'une Antenne rectangulaire 

microruban à des fentes à l'aide d'une technique d'alimentation par sonde coaxiale par le 

logiciel Ansoft HFSS . Le concept de conception consiste à incorporer des  fentes dans 

le patch rayonnant d'une antenne patch microstrip conventionnelle de 5,5 GHz afin de 

créer trois bandes de fréquences. Pour atteindre cet objectif, le présent travail est  réparti 

sur  trois chapitres : 

 

           Dans le premier chapitre, nous présenterons une définition générale des antennes 

et leurs caractéristiques, plus particulièrement les antennes patchs, nous présenterons 

également leur configuration de base, leurs techniques d'alimentation, leurs mécanismes 

de rayonnement, ainsi leurs avantages et inconvénients et enfin nous citerons leurs 

domaines d’application. 

De nos jours les études et les recherches sur le domaine des antennes sont  très 

évoluées, que ce soit sur le plan théorique ou pratique, ce qui veut dire  l’établissement 

de nouvelles conceptions ; le but principal des chercheurs est de les miniaturiser tout en 

gardant leurs propriétés voir même les optimiser. Pour économiser les ressources 

destinées à la conception, on fait appel à la simulation électromagnétique (EM) qui est 

un outil essentiel dans la conception moderne des filtres et des antennes. Les techniques 

de simulation EM ont évolués rapidement pour atteindre un niveau de précision très 

important. Ces outils de simulation ont permis d'accélérer le processus de conception, 

permettant de concevoir des prototypes virtuels. On prend comme exemple le logiciel 

HFSS (High Frequency Structure Simulation) qui est l’un des plus performants sur le 

marché,  est le logiciel choisi dans notre projet ses fonctionnalités sont présentées dans 

notre deuxième  chapitre. 

 le troisième chapitre est dédié à la conception d'une antenne rectangulaire 

microruban à fentes en utilisant la technique d'alimentation par sonde coaxiale simulé à 

l'aide du logiciel de Simulation électromagnétique HFSS. Le concept de conception 

consiste à incorporer des fentes dans le patch rayonnant d'une antenne patch microstrip 

conventionnelle de 5,5 GHz afin de créer trois bandes de fréquences.  Deux géométries 

de fentes sont insérées, une fente rectangulaire et une fente de forme 8. Les positions et 

les dimensions des fentes sont déterminées à l'aide d'une analyse paramétrique. En effet, 

une technique d'optimisation, en utilisant un algorithme Matlab, est exploitée pour 



Introduction générale 
 

                                                                                    3 

 

sélectionner la meilleur géométrie de l'antenne qui corresponde au meilleur 

comportement triple bandes. les résultats de simulation et la discussion sont mentionnés 

sur ce chapitre. 

 Enfin, le mémoire se termine par une conclusion générale et une bibliographie 
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       I.1 Introduction  

Dans tous les systèmes de communication sans fil, les antennes jouent un rôle très 

important dans l'amélioration de ses performances. Pour tels systèmes, les antennes 

constituent des éléments indispensables pour assurer le couplage entre les 

équipements et le milieu de propagation [4]. Les antennes varient entre elles à travers 

plusieurs choses telles que la taille, la forme, la bande de fréquences, le gain, la 

polarisation,...etc. Ceci tout dépend du domaine d'application. 

Aujourd'hui, la technologie est très intéressée par le développement d'antenne patch, 

qui est actuellement utilisé dans de nombreux appareils électroniques (téléphone 

mobile, ordinateur, GPS, Radar,...etc). 

Dans ce chapitre, nous présenterons une définition générale des antennes et leurs 

caractéristiques, plus particulièrement les antennes patchs, nous présenterons 

également leur configuration de base, leurs techniques d'alimentation, leurs 

mécanismes de rayonnement, ainsi leurs avantages et inconvénients et enfin nous 

citrons leurs domaines d’application. 

I.2 Définition d’une antenne 

 L’antenne est un élément essentiel dans les systèmes de télécommunication. Selon la 

définition standard IEEE des termes relatifs aux antennes, une antenne est définie 

comme une moyenne de rayonner ou de recevoir des ondes radio [5]. En d’autre 

terme, l’antenne est un dispositif qui fait le couplage entre les ondes guidées, issue 

d’un générateur de puissance et les ondes rayonnées dans l’espace libre (convertisseur 

et transformateur de puissance). Elle est utilisée pour émettre et pour recevoir les 

ondes électromagnétiques.  

I.2.1 Antenne d’émission  

Le rôle de l’antenne d’émission est de transformer la puissance électromagnétique 

guidée, issue d’un générateur en une puissance rayonnée (transducteur) [1].  

I.2.2 Antenne de réception 

 Est le rôle inverse d’une antenne d’émission. Elle est utilisée pour capter et 

transformer la puissance rayonnée électromagnétique en une puissance électrique. 

Dans la plupart des cas, une antenne peut être utilisée en réception ou en émission 
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avec les mêmes propriétés rayonnantes on dit que son fonctionnement est réciproque 

[1]. 

  

Figure I.1 : Système de transmission. 

I.3 Antennes microbandes 

Le concept d’antenne micro-ruban, ou antenne imprimée, a été proposé par 

Deschamps en 1953[6] , mais au milieu des années 70, les premières véritables 

contributions au domaine de la technologie des micro-rubans ont été apportées. Les 

antennes micro-ruban ont attirées   l'attention d'un grand nombre de chercheurs et des 

ingénieurs et ont été largement utilisées dans les systèmes Radio fréquences et 

hyperfréquences. C'est un type d’antenne qui a un faible   volume,  un faible poids, un 

faible coût, hautes performances et facilité de mise en œuvre. 

I.3.1 Description des antennes microbande 

Une antenne à éléments rayonnants imprimés « Figure I.2 », communément appelée  

antenne  patch est une ligne micro-ruban (micro-strip) de forme particulière.  

Elle effectue ainsi deux fonctions fondamentales qui définissent le principe d’antenne 

de manière générale, il s’agit bien du rayonnement (émission) et de la réception d’une 

onde électromagnétique 
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Figure I.2: Configuration de base d’une antenne patch [7]. 

Cette antenne se compose de :  

Le plan de masse (ground plane) : est une surface conductrice (cuivre) recouvrant la 

partie inférieure du substrat. Elle permet de faire rayonner la partie supérieure. 

Un substrat diélectrique (dielectric substrat) : composé d’un matériau isolant, 

d’épaisseur généralement faible devant la longueur d’onde et de permittivité relative 

(2,2<𝜀𝑟<12). Il est utilisé  pour augmenter la puissance. 

L’élément rayonnant (patch) : est une partie métallique de forme et de taille à 

définir selon  l’application, à géométrie variable (circulaire, rectangulaire, triangulaire 

…etc.). Il doit être relié  au reste du circuit par une ligne de transmission (micro-

ruban) qui doit être adaptée d’impédance à  l’antenne et au reste du circuit afin 

d’éviter le phénomène de réflexion. 

 Les différentes formes d'une antenne patch 

Le patch et le plan de masse sont généralement en cuivre. Le patch peut prendre 

différentes formes,  telles que le rectangle, le carré, l’ellipse, le cercle, le triangle, 

l’anneau, le pentagone,…etc.[8] 
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Figure I.3: Différentes formes du patch. 

Le choix de la forme du patch dépend des caractéristiques souhaitées, comme la 

polarisation, le gain, la directivité, largeur de bande passent,…etc. D’une manière 

générale, les caractéristiques de l’antenne sont définies par les modes de 

fonctionnement excités[8]  qui dépendent de la forme et  la  dimension du patch, du 

substrat diélectrique et de son épaisseur, et de dispositif d'alimentation.    

I.4 Les caractéristiques des antennes : 

I.4.1 Le coefficient de réflexion S11 

Le coefficient de réflexion met en évidence l’absorption de l’énergie par   l’antenne. 

Les discontinuités  présentées par l’antenne peuvent être caractérisées par le 

coefficient de réflexion, qui est lié à l’impédance d’entrée par la relation (I.1) : 

    𝑆11 =
Zr−Zc

Zr+Zc
                                                                                                           (I.1)  

Où : Zc est l’impédance de normalisation, en générale égale à 50Ω. Ce paramètre 

permet de caractériser l’adaptation de l’antenne.[10].             

1.4.2 La bande passante 

La bande passante d’une antenne correspond à la bande de fréquence où le transfert 

d’énergie de l’alimentation vers l’antenne (ou de l’antenne vers le récepteur) est 

maximale.  La bande passante peut être définie en fonction du coefficient de 

réflexion, à condition que le diagramme  de rayonnement ne change pas sur cette 

bande. Il n’y a pas de critères précis pour la  limite du coefficient de réflexion.  
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Un critère typique d’avoir un coefficient de réflexion inférieure à -10 dB sur la bande 

passante ou un VSWR inférieur à 2  [11]. 

 

 

                        

 

 

 

 

Figure I.4: Bande passante et coefficient de réflexion[17]. 

La bande passante est définie par la formule suivante : 

𝑩𝑷=
f2−f1

f0
                                                                                                      (I.2) 

I.4.3 La directivité  

caractérise la concentration du rayonnement dans une direction donnée [10]. 

      D (θ, φ) =
P(θ,φ)

(¼𝜋) ∫ P(θ,φ)ԀΩ
₄𝜋

𝟶

                                                                                  (I.3)                                       

Avec :  

 P(θ,φ). : densité de la puissance reçue de l’émetteur. 

 (¼𝜋) ∫ P(θ, φ)ԀΩ
₄𝜋

𝟶
: densité de puissance moyenne rayonnée dans toute 

l’espace. 

 D (θ φ): la directivité de l’antenne. 

I.4.4 Rendement de l’antenne 

Le rendement de l’antenne est le rapport entre la puissance rayonnée et la puissance 

fournie à  l’antenne [9]. 

𝜂= 
pr

pf
                                                                                                                          (I.4) 

Avec : 

 Pr : la puissance rayonnée par l’antenne. 
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 Pf : la puissance fournie à l’antenne. 

I.4.5 Le gain 

           est le résultat de la directivité sur de la perte [9]. 

        G (θ, φ)= 𝜂 *D (θ, φ)                                                                                         (I.5) 

 𝜂: le rendement de l’antenne 

 D (θ, φ) : la directivité de l’antenne 

 G (θ, φ) : le gain de l’antenne 

I.4.6 L'impédance d'entrée de l'antenne  

L’impédance d’entrée de l‘antenne est l’impédance vue de la part de la ligne 

D’alimentation au niveau de l’antenne. Cette impédance est donnée par la formule 

[10] : 

Zin =
1−S11

1+S11
                                                                                                                (I.6) 

I.4.7 Diagramme de rayonnement 

Le diagramme de rayonnement d’une antenne, présente les variations de la puissance 

rayonnée par l'antenne dans différentes directions de l'espace. Il indique la direction 

dans l'espace dans laquelle la puissance  rayonnée est  maximal [12] . 

Figure. I.5: Diagramme de rayonnement de surface et de courant[13]. 

La Figure I.6 ci-dessous présente une représentation en trois dimensions des formes 

de diagrammes de rayonnement que nous venons de présenter. 
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a – isotrope                      b -  omnidirectionnel     c - directif 

Figure I.6: Exemple de diagramme de rayonnement d’antenne [14]. 

Il est donné par la relation suivante :  

r (θ, φ)= 
P(θ,φ)

P(θ0,φ0)
                                                                                                        (I.7)    

I.5 Les avantages et inconvénients 

Les antennes imprimées comportent plusieurs avantages, les plus importants sont les 

suivants [15] : 

 Faible poids. 

 encombrement  réduit. 

 conformations  possibles. 

 Faible coût de fabrication, production en masse facile. 

 Rayonnement en polarisation linéaire et circulaire possibles. 

 Antennes multi-bandes, multi-polarisations. 

 Compatibilité avec les circuits hybrides. 

Les antennes imprimées présentent un nombre non négligeable d’inconvénients: 

 Faible efficacité de rayonnement. 

 Supporte uniquement des faibles puissances.       

 Impureté de la polarisation. 

 Rayonnement parasite de l’alimentation et des ondes de surface. 

 Faible gain. 

 Bande passante étroite. 

I.6 Les techniques d'alimentations 

L’alimentation de l’antenne dépend de la manière dont  l’antenne est intégrée dans le 

dispositif. 
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I.6.1  Alimentation par sonde coaxiale 

L'alimentation coaxiale ou l'alimentation par sonde est une technique très connue, 

utilisée pour alimenter les antennes plaques. Le conducteur intérieur du connecteur 

coaxial s’étend à travers le diélectrique et il est soudé au patch, alors que le 

conducteur extérieur est relié au plan de masse « Figure I.7». 

L'avantage principal de ce type d'alimentation est qu’elle peut être placée à n’importe 

quel endroit   désiré   du patch afin d’assurer l’adaptation d’impédance. Cette méthode 

d'alimentation   est facile à fabriquer et a un rayonnement parasite faible. Cependant, 

son inconvénient principal est qu'elle fournit une  bande passante étroite et elle est 

difficile à modéliser puisqu'un trou doit être foré dans le substrat et le connecteur sort 

en dehors du plan de masse, cela ne la rend pas complètement planaire pour les 

substrats épais (h >0.002 λ0) [7]. 

Figure I.7: Alimentation du patch rectangulaire avec un câble coaxiale[16]. 
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I.6 .2 Alimentation par ligne micro-ruban 

 Dans ce cas d’alimentation, on relie une ligne micros trip au patch. Cette ligne lui 

amène de l’énergie. Il existe cependant un inconvénient dans ce type d’alimentation 

vu qu’elle génère un  rayonnement  parasite . 

Figure I.8: Alimentation du patch rectangulaire par une ligne micro ruban [16]. 

I.6 .3 Alimentation couplée par ouverture 

Dans ce type d'alimentation, le patch  rayonnant et la ligne micro-ruban d'alimentation 

sont séparés par le plan de masse comme représentée dans la « Figure I.9». Le 

couplage entre le  patch et la ligne d'alimentation est assuré par une fente ou une 

ouverture dans le plan de masse. 
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Figure I.9: Alimentation couplée par ouverture[16]. 

I.6.4 Alimentation par le couplage par proximité 

Ce type d’alimentation Offre la meilleure bande passante, il est facile à modéliser et 

présente un rayonnement parasite faible. La distance entre la ligne d'alimentation et le 

patch peut être  utilisé pour  adapter l'impédance de l'antenne. Le principal 

inconvénient de ce type d'alimentation est qu'il est difficile à mettre en œuvre. 
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Figure I.10: Alimentation du patch rectangulaire par couplage[16]. 

I.7 Comparaison entre les types d’alimentation 

Les types d’alimentation les plus utilisés sont l’alimentation par câble coaxial et 

l’alimentation par  ligne micro ruban, à cause de facilité de mise en ouvre, par contre 

les autres types sont plus complexes.  Le tableau suivant présente une comparaison 

entre les différents types d’alimentation 
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Caractéristiques Alimentation 

par  micro 

ruban 

Alimentation 

coaxiale 

Alimentation 

par ouverture 

Alimentation 

par proximité 

Rayonnement  

parasite 

plus plus Moins Minimum 

Fiabilité Meilleur Pauvre Bon Bon 

Facilité de 

fabrication 

Facile Soudure et 

Forage requis 

Alignement 

requis 

Alignement 

requis 

Bande passante 2 à 5% 2 à 5% 2 à 5% 13% 

Tableau I.1 : Comparaison entre les différentes méthodes d'alimentation [17]. 

I.8 Mécanisme de rayonnement d’une antenne patch  

Le mécanisme de rayonnement d’une antenne patch, se comprend à partir de sa forme 

géométrique [17]. Ce rayonnement d’antenne patch produit à partir des champs 

frangeants entre le  bord du conducteur de l'antenne patch et le plan de masse (Figure 

I.11(b)). Lorsque  on excite la ligne d’alimentation, il y a une onde électromagnétique 

qui va se propager sur cette dernière pour rencontrer l’élément rayonnant qui est 

généralement plus large que la ligne, à cause de distribution de charge s’établir sur et 

sous le composant rayonnant et entre le plan de masse et le substrat. Ce phénomène 

est illustré par la Figure I.11 (a). 

 

Figure I.11 : Distribution de charge du champ dans l'antenne patch. 

Avec, JD est le courant de déplacement, et Jt le courant de surface. 

En supposant qu'il n'y ait aucune variation du champ électrique le long de la largeur et 

de l'épaisseur de la structure à micro ruban, la configuration du champ électrique du 

radiateur peut être représentée comme indiqué sur la Figure I.12. Les champs varient 

par la variation de la longueur du  patch, ce qui correspond à environ une demi-

longueur d’onde (𝜆/2) pour le mode fondamental. 
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Figure I. 12 : Configuration du champ électrique du radiateur. 

I.9 Les applications des antennes 

Grâce à leurs nombreux avantages, par rapport aux quelques inconvénients, les 

antennes imprimées sont utilisées dans beaucoup de domaines : de l’électronique 

grand public aux systèmes technologiques de pointe. Parmi ces domaines, on peut 

mentionner : la télémétrie et les antennes de communication sur les missiles, le radar, 

l'aviation, les liaisons de communication entre les navires ou les satellites 

géostationnaires, les armes intelligentes, les systèmes  GPS…. 

I.10 Conclusion 

Dans ce chapitre nous avons présenté un contexte général sur les antennes  patchs.  

Nous avons  commencé par leurs caractéristiques, après nous avons vu leurs  

techniques d’alimentation, leurs mécanismes de rayonnement, leurs avantages et  

inconvénients, et ainsi leurs domaines d’application. Les performances d’une antenne 

patch peuvent être contrôlées par ses paramètres constitutifs, tels que le type 

d’alimentation, la forme et les dimensions d’élément rayonné (patch)  et du plan de 

masse, ainsi que l’épaisseur et le type de substrat. Dans le chapitre suivant on va 

donner une description du logiciel HFSS et son environnement de travail dans le quel 

on va  implémenter les différentes structures à étudié.  
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II.1 Introduction 

HFSS est un logiciel de modélisation électromagnétique et d'analyse des circuits passifs et des 

structures tridimensionnels. Il aide le concepteur à observer et analyser les diverses propriétés 

électromagnétiques de la structure tels que les caractéristiques de rayonnement et de la 

dispersion. Il est important de comprendre chaque étape du processus de modélisation en détail 

afin d'obtenir des résultats fiables.  Ce chapitre est consacré à la présentation du logiciel HFSS 

(High Frequency Structure Simulator), ses fonctionnalités et présenter de façon générale le rôle 

de chaque fonction que nous allons utiliser pour réaliser nos simulations.  

II.2 Présentation du logiciel Ansoft HFSS 

Le logiciel HFSS (High Frequency Structure Simulation) version 19.20 de Ansoft Corporation 

est un logiciel commercial qui calcule des champs électromagnétiques dans le domaine 

fréquentiel en résolvant localement les équations de Maxwell. Pour cela,(type de matériau, 

taille, épaisseur, …). Il est également nécessaire de spécifier les sources électromagnétiques. 

Il est possible de paramétrer le système et de faire varier ces paramètres lors de la simulation. 

L’un des intérêts de HFSS est sa capacité de donner directement les paramètres S, Y, Z en 

fonction de la fréquence. Les principales étapes d’un "Design" HFSS sont illustrées par 

l’organigramme suivant : 
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Figure II.1: Organigramme des différentes étapes d’un design HFSS [18] 

II.3 avantages et inconvénients du HFSS 

Les avantages et les inconvénients de ce logiciel sont: 

 Complexité de travail et de création des structures (plusieurs détails de conception). 

 La nécessité d’avoir maitrisé l’utilisation du logiciel, avant d’aborder le projet, parce 

qu’on est obligé de se servir des opérations booléennes parfois, pour dessiner des 

surfaces ou formes n’ayant pas une forme géométrique bien définie. 

 En plus on doit faire attention aux frontières (Boundaries), il ne faut pas avoir des 

conflits entre une surface de radiation par exemple et une surface conductrice. 
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 La simulation pourra prendre une durée de plusieurs heures jusqu’aux plusieurs jours 

parfois, surtout si le projet à simuler est d’un volume relativement grand, et présente 

beaucoup de détails. [19] 

II.4 Comment commencer HFSS 

HFSS devrait être installé sur l'ordinateur que vous travaillez dessus. Il devrait y avoir une 

icône de HFSS ( ) sur l'ordinateur de bureau que vous pouvez double-cliquer pour 

lancer HFSS [19]. 

II.5 Comment ouvrir un nouveau projet 

Quand vous commencez HFSS v 19.20, un projet est énuméré dans l'arbre de  projet 

dans la fenêtre de Project Manager et est appelé project1 par défaut. Des définitions de 

projet, telles que la tâche matérielle, des états de frontière, et des ports d'excitation sont 

stockées sous le nom de projet. 

II.6 Sauvegarder le projet 

Sur le menu fichier, cliquer Save As, employer le navigateur de dossier pour   localiser le 

dossier dans lequel vous voulez sauvegarder le projet comme C:\Ansoft\ 

HFSS19\Projects, et double-cliquer le nom de dossier, puis cliquer Save . 

II.7 Description générale des outils HFSS 

La fenêtre d'Ansoft HFSS a plusieurs panneaux facultatifs : 

 

 

 

 

 



Chapitre II                                                                                Présentation du logiciel HFSS 

 

                                                                                           22 

 

Figure II.2 : Les outils de HFSS. 

 Barre des outils : Elle englobe tous les outils pour créer un model : 

 Rotation et zoom du model 

 

 Type du matériau utilisé 

 

 Le plan dans lequel on dessine l’objet 

 

 Raccourci des modèles du carré jusqu’au cône : 
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 Sélectionner une face : 

 

  La fenêtre de 3D Modeler:   contient le modèle et son arbre pour la conception. 

 Gestionnaire de projet arborescent (Manager des projets) 

Contient un arbre de conception qui énumère la structure du projet 

Figure II.3 : Manager des projets. 



Chapitre II                                                                                Présentation du logiciel HFSS 

 

                                                                                           24 

 

 La fenêtre de Propretés: nous permet d’attribuer le nom, le matériau, la 

couleur…etc. 

Figure II.4 : Fenêtre des propriétés. 

Commandes : on trouve la position et les paramètres (hauteur, largeur) du model, on  

peut les  modifiés à n’importe quel moment durant le travail. 

Figure II.5 : les paramètres (hauteur, largeur) du model. 

 Le Message Manager: permet d'afficher tous les erreurs avant de  commencer la 

simulation. 

 La fenêtre de Progress: affiche les progressions de la solution. 

 Barre des menus : Elle contient toutes les options d’HFSS notamment : 

HFSS>>Edit : 

Arrange > 
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Move : translater un élément de la structure le long d’un vecteur. 

Rotate : déplacer un élément de la structure par un angle. 

Mirror : faire translater un objet choisi autour d'un plan spécifié. 

Offset: Effectue une échelle uniforme en x, y et z. 

Duplicate> 

Along lines : Créer des copies multiples d’un objet le long d'un vecteur. 

Around axis : créer des copies multiples d’un objet en rotation par un angle fixe autour de 

x, y ou z. 

Mirror : Fixer l’image d’un objet autour d'un plan spécifié et créer son  double. 

Draw : Regroupe tous les modèles, rectangle, ellipse, cercle, boite….. 

HFSS : contient les fonctionnalités principales : 

 Solution Type (type de la solution): 

 Modal : Permet de calculer S11 d'une structure en haute    fréquence en 

fonction des ondes incidentes et réfléchies [18]. 

 Terminal : nous permet de calculer les paramètres S de mode des structures 

passives haute fréquence tel que les micro rubans, les guides d'ondes et les 

lignes de transmission excitées par une source [18]. 

 Eigenmode : Permet de calculer la fréquence de résonance de la structure 

et les champs à ces fréquences [18]. 
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Figure II.6 : type de solution. 

 Validate : (compiler le projet) si tout est bon la fenêtre ci-dessous apparait : 

Figure II.7 : compiler le projet. 

Pour voir s’il ya des erreurs ou des warnings veuillez consultez le message manager qui 

se  trouve en bas de la fenêtre. 

 Analyze all :     ça prendra de 5-20min pour faire l’analyse ça dependra de votre 

machine. 

Une barre de progression va paraitre en vert à la fin de l’analyse vous aurez ce message : 
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 Boundaries (conditions aux limites) 

Figure II.8 :Création des conditions aux limites (boundary). 

  Perfect E : également appelé conducteur parfait ce type de limite le champ électrique est 

perpendiculaire à la surface. Il y a également deux affectations définissant un conducteur 

automatiquement parfait 

o Toute surface de l'objet qui touche le fond est automatiquement définie comme une 

limite parfaitement conductrice et donné le nom de condition aux limites extérieures. 

o Tout objet assigné par un matériel PEC (Perfect Electric conductor) il est 

automatiquement attribué à la condition aux limites électriquement parfait. 

 Perfect H : est un conducteur magnétiquement parfait, il est tangentiel à la surface 

du champ E. 

 Finite Conductivity: limite de conductivité finie, vous permet de définir la surface 

d'un  objet comme un conducteur avec perte (imparfait). 

 Impedance : surface résistive qui calcule le comportement des champs et des pertes 

en utilisant des formules analytiques(Rs+jXs). Avec Rs : résistance, Xs : réactance. 

 Layered Impedance : plusieurs couches minces dans une structure peuvent être 
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modélisées comme une surface d’impédance 

 Lumped RLC : une combinaison en parallèle des résistances localisées, inductance, et 

/ou de la surface du condensateur, la simulation est similaire à celle d’une impédance. 

 Radiation : limites de rayonnement, aussi appelé frontières absorbantes, vous 

permettent de modéliser une surface électriquement ouverte: ondes peuvent alors sortir de 

la structure et s’arrêter vers la limite du rayonnement. 

 Excitations 

Pour le type de solution "Driven Model" nous avons les types d’excitations suivantes : 

 Wave Port : Représente la surface par laquelle un signal entre ou sort de la 

géométrie.  

 Onde Incidente : Représente la propagation d'une onde incidente sur la  géométrie.  

 Lumped Port : Représente une surface interne par laquelle un signal   entre 

ou sort  de  la géométrie.  

 Incident Wave : Représente un champ électrique constant à travers les points 

d’une  alimentation.  

 Volotage Source : Représente un courant électrique constant à travers les 

points d’une  alimentation.  

 Current : Représente un courant électrique constant à travers des points  

d’excitations. 

 Magnetic Bias : Utilisé pour définir le champ intérieur net qui influe sur un  objet 

de matériau ferromagnétique en 3D. 
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Figure II.9: types d'excitations. 

 Analyze Setup: les conditions d’analyse notamment la fréquence et son intervalle 

d’utilisation. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure II.10: Analyze Setup. 
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 Add Solution Setup : 

Figure II.11: Solution setup. 

II.8  Etapes de simulation par HFSS 

Pour simuler une antenne patch en utilisant le simulateur HFSS, il faut passer par un 

certain nombre d’étapes résumées comme suit : 

1. schématiser la structure réelle de la structure : dimensions géométriques des différents  

objets. 

2. Spécification des matériaux pour chaque objet : choix du matériau, constantes 

diélectriques, conductivité des matériaux ... 

3. Identification des sources et (ou) ports d’entrée/sortie : Manière d’exciter la structure, 

consiste à injecter la puissance sous forme d’onde électromagnétique à travers la porte 

d’alimentation déjà définie. 

4. Spécification des conditions aux limites : La résolution des équations d’ondes dans une 

structure quelconque exige la spécification des conditions aux frontières. En effet, le 

comportement des champs électromagnétiques dans le milieu en question dépend 
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étroitement des frontières de la structure utilisée. Pour les types de frontières: CCE, CCM, 

rayonnantes. 

5. Configuration des paramètres de simulation : Fréquence(s) de maillage, paramètres de 

convergence. 

6. Analyse des solutions à un ou plusieurs fréquences : Après avoir vérifié la conformité de 

la structure aux exigences du HFSS, les conditions aux frontières et l’excitation, la 

simulation sera prête à être lancée. La durée de cette simulation dépend essentiellement de 

a. La vitesse du calculateur (ordinateur) utilisé. 

b. La complexité de la structure (volume, dimensions etc.) 

c. La bande de fréquence de l’analyse.  

7. Visualisation des résultats : Le diagramme de rayonnement dans les plans E et 

H.paramètres S (+paramètres z, y etc.). 

8. Discussion et exploitation des résultats par l’utilisateur. 

II.9 Exemple d’étapes de simulation d’antenne Patch rectangulaire alimenté Par 

câble coaxial  

La simulation de cette antenne est réalisée en utilisant le logiciel HFSS. 

 Ouvrir un nouveau projet et nommer le Project1 : 

 HFSS > Solution Type  Terminal 

 

                    

 

 

 

 

 

 

 

Figure II.12: Sélection de type de solution. 
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 Choisir l’unité dans la fenêtre  Modeler > Units > cm puis OK. 

 

                        

 

 

 

 

Figure II.13 : Sélection des unités. 

II.9.1 Créer le substrat 

Draw>Box ou clique sur  

Pour dessiner le substrat, cliquer dans la barre4 d’outils. Dessiner alors une boîte. 

En utilisant les surfaces d'entrées du même rang, entrer la position et dimension de Box  

comme montré dans la figure suivante : 

Figure II.14 : Position et dimensions de Box. 
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Ecrire le nom et choisir la matière de substrat : 

1-Choisir la case Attribut à partir de la fenêtre de Properties 

2- Pour la Valeur du type Name: sub1. 

3- Pour la Valeur du type Material: (("RogersRT/douroid5880(tm)") 

4-Cliquer sur le Bouton OK 

Figure II.15: Matière de substrat. 

 Adapter la vue: 

Choisir dans le menu View> Fit All > Active View, ou appuyer sur les touches Ctrl + D  

(Raccourci). Le substrat est illustré dans la Figure III .16 : 
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Figure II.16 : Substrat diélectrique. 

II.9.2 Créer le plan de masse infini 

Draw>Rectangle 

En utilisant les champs de saisie des coordonnées, entrez la position du rectangle. 

X: -2.1, Y: -1.8, Z: 0.0, appuyez sur la touche Entrée. 

En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle: 

Dx : 3.6, dy: 4.2, dZ: 0.0, appuyez sur la touche Entrée. 

Nommé le : inf_gnd .La figure ci-dessous montre le résultat : 

Figure II.17 : Plan de mass (inf_gnd). 
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II.9.3 Attribuer une frontière perfect E au plan de masse infini 

Edit>Select>By Name On sélectionne: inf_gnd 

 

 

 

 

 

 

FigureII.18:Perfect E 

HFSS>Boundaries>Assign>Perfect E 

La fenêtre s’ouvre, entrez le nom suivant : PerfE1 

La radiation est illustrée ci-dessous : 

Figure II.19 : Assignement de la condition "Conducteur parfait" pour le plan de masse. 

II.9.4 Créer le plan de masse infini Cut Out 

Draw>Circle 

En utilisant les champs de saisie des coordonnées, entrez la position 
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X: 0.0, Y: 0,34, Z: 0.0, appuyez sur la touche Entrée 

En utilisant les champs de saisie des coordonnées, entrez le rayon: 

Dx : 0.155, dy: 0.0, dZ: 0.0, appuyez sur la touche Entrée 

Définir le nom: Cut_Out 

Sélectionnez les deux objects inf_gnd et Cut_Out: 

Modeler>Boolean>Subtract: 

Blank Parts: inf_gnd Tool Parts: Cut_Out 

 

Figure II.20: Cut_out. 

II.9.5 Créer le Patch 

Draw>Rectangle 

En utilisant les champs de saisie des coordonnées, entrez la position du rectangle X: -1.08, 

Y: -0.875 Z: 0.062, appuyez sur la touche Entrée. 
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En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle: dx : 

2.16, dy: 1.75, dZ: 0.0, appuyez sur la touche Entrée. 

La fenêtre des propriétés s’ouvre automatiquement entrez le nom: Patch 
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Figure II.21 : création de patch. 

II.9.6 Attribuer un champ perfect E pour le patch 

Sélectionnez le patch allez vers HFSS>Boundaries>Assign>Perfect E 

Nommé: PerfE 2 cliquez sur OK. 

Figure II.22 : Assignement de la condition "Conducteur parfait" pour le patch. 

II.9.7 Créer le câble coaxial 

Pour le dessin du coaxial: 

Draw>Cylinder 
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En utilisant les champs de saisie des coordonnées, entrez la position du cylindre X: 0.0, Y: 

0.34, Z: 0.0 Appuyez sur la touche Entrée. 

À l'aide des champs de saisie des coordonnées, entrez le rayon: dX: 0.155, dY: 0.0, dZ: 0.0 

Appuyez sur la touche Entrée. 

Utiliser les champs de saisie des coordonnées, entrez la hauteur: dX: 0.0, dY: 0.0, dZ: 

 -0.91 Appuyez sur la touche Entrée. 

Material: vacuum. 

Nommé : Coax. 

cliquez sur Ok. 
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Figure II.23 : dessin du coaxial. 

II.9.8 Créer l’âme du coaxial 

Draw>Cylinder 

En utilisant les champs de saisie des coordonnées, entrez la position du cylindre X: 0.0, Y: 

0.34, Z: 0.0 Appuyez sur la touche Entrée. 

À l'aide des champs de saisie des coordonnées, entrez le rayon DX : 0.045, dy: 0.0, dZ: 0.0 

Appuyez sur la touche Entrée. 

Utiliser les champs de saisie des coordonnées, entrez la hauteur: DX 0.0, dy: 0.0, dZ: -0.91 

Appuyez sur la touche Entrée. 

Nommé: Coax_Pin. 
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Material: pec 

 

 

Figure II.24 : l’âme du coaxial. 
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II.9.9 Créer le port d'onde (wave port) 

Pour créer un cercle qui représente le port: 

Cliquez sur Draw> Cercle 

En utilisant les champs de saisie des coordonnées, entrez la position X: 0.0, Y: 0,34, Z: -

0.91 Appuyez sur la touche Entrée. 

À l'aide des champs de saisie des coordonnées, entrez le rayon du cercle DX :0.155, dy: 

0.0, dZ: 0.0: Appuyez sur la touche Entrée . 

Dans la fenêtre Propriétés 

nom: Port1. 

cliquez sur le bouton OK. 

Sélectionnez: Port1. 

II.9.10 Attribuer une excitation au port d’onde 

HFSS>Excitations>Assign>Wave Port 

Spécifié le nom: 1 

Le terminal est p1 dans l'arborescence du projet. 

 

L’excitation est illustrée ci dessous: 

 

Figure II.25 : Excitation wave-port. 
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II.9.11 Création de la sonde (probe) 

Cliquez sur Draw> Cylinder 

En utilisant les champs de saisie des coordonnées, entrez la position du cylindre X: 0.0, Y: 

0,34, Z: 0.0 Appuyez sur la touche Entrée. 

À l'aide des champs de saisie de coordonnées, entrez le rayon: Dx : 0.07, dy: 0.0, dZ: 0.0 

Appuyez sur la touche Entrée. 

Dx : 0.045, dy: 0.0, dZ: 0.0 Appuyez sur la touche Entrée. 

Utiliser les champs de saisie des coordonnées, entrez la hauteur: DX 0.0, dy: 0.0, dZ: 0,062 

Appuyez sur la touche Entrée. 

Dans la fenêtre Propriétés nom: Probe. 

Matériel: pec. 
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Figure II.26: Sonde (probe). 

II.9.12 Créer l’Air 

Cliquez sur Draw>Box 

En utilisant les champs de saisie des coordonnées, entrez la position de la boîte X: -2.1, Y: 

-1.8, Z: 0.0, appuyez sur la touche Entrée. 

À l'aide des champs de saisie des coordonnées, entrez le coin opposé de la boîte DX :4.2, 

dy: 3.6, dZ: 1.062. 

Définir le nom: air_box. 

Pour s'adapter à la vue: Cliquez sur View>Fit All>Active View 
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Figure II.27 : Boitier d’air. 
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II.9.13 Assigner les conditions aux limites (Radiation Boundary) 

Sélectionnez les faces : 

Cliquez sur Edit>Select>Faces 

Sélectionner graphiquement toutes les faces de l'objet, sauf la face à Z = 0.0cm (le fond). 

     Pour créer une limite de rayonnement HFSS>Boundaries>Assign >Radiation 

La boîte de dialogue des limites des rayonnements s'ouvre, nommé: Rad1 

La radiation est illustrée ci dessous: 

Figure II.28 : Assignement des frontières. 

II.9.14  Créer une configuration du rayonnement (radiation setup) 

Pour définir la configuration de rayonnement 

HFSS>Radiation>Insert Far Field Setup>Infinite 

La boîte de dialogue Far Field Radiation Sphere Setup s'ouvre 

Sélectionnez l'onglet sphère infinie : 

Nom: Infinite Sphere1 

Phi: (Début: 0, Arrêt: 90, Step Taille: 90) 

Theta: (Début: -180, Arrêt: 180, Step Taille: 2) 
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Cliquez sur OK. 

Figure II.29: Configuration du rayonnement. 

II.9.15 Créer une installation d'analyse (analysis setup) 

Choisir „‟ Add Solution Setup„ dans le menu HFSS >Analysis Setup >Add    Solution 

Setup. 

1) Dans la Fenêtre de Solution Setup 

 Cliquer sur la case General: 

 Solution fréquence: 5, 5 GHz 

 Nombre maximum de passes: 20 

Delta maximale: 0.02 

 Cliquer sur le Bouton OK. 
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Figure II.30 : Solution d’analyse (fréquentielle). 

II.9.16 Ajouter le champ de fréquence (Add Frequency Sweep) 

Pour ajouter un champ de fréquence, choisir (Add Sweep) dans le menu HFSS 

>Analysis Setup   >Add Sweep. Choisir la solution pour installer :Setup1. Cliquer 

le bouton OK. La fenetre du  type de champ de fréquence s’active alors : Fast, 

Frequency Linear Count, Start: 3 GHz,  Stop: 7 GHz,Count: 200. Clique OK 
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Figure II.31: Plage de fréquence et type d’analyse. 

II.9.17  Analyse 

Pour valider le modèle: 

1. Choisir Check dans le menu HFSS > Validation > Check. 

2. Cliquer sur le Bouton Close. 

Figure II.32 : Vérification des étapes de simulation. 

Pour commencer le processus de solution: 
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Choisir dans le menu HFSS >Analyze All 

 

II.9 .18 Créer les rapports  

Après la simulation, pour créer le rapport de données de solution, il faut suivre les 

étapes suivantes : HFSS >Result>CreateRepport. 

Figure II.33: Affichage des résultats. 

Pour afficher le coefficient de réflexion S11 suivre les étapes suivantes comme illustré sur 

la Figure II.34. 
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        Figure II.34: Affichage S11. 

Pour afficher le rapport d'onde stationnaire VSWR suivre les étapes suivantes comme 

illustré sur la figure 

 

 

 

 

 

 

 

 

 

 

 

 

Figure II.35: Affichage VSWR. 

Le diagramme de rayonnement est obtenu en suivant les étapes suivantes: 



Chapitre II                                                                                Présentation du logiciel HFSS 

 

                                                                                           52 

 

Figure II.36: Affichage de diagramme de rayonnement. 

 

Les résultats de simulation de cette antenne (S11, VSWR et diagramme de rayonnement) 

sont mentionnés au chapitre 3. 
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II .10 Conclusion 

Dans ce chapitre, nous avons présenté des informations sur un logiciel (HFSS) et expliqué 

les différentes étapes de création d'un design HFSS et la descriptions générales des 

différents outils : barre d’outils, barres des menus, Fenêtre, Manager des projets, Etapes de 

simulation etc .Nous avons pris un exemple de simulation d’antenne patch rectangulaire 

alimentée par un câble coaxiale, Après cette description nous Sommes prêts à réaliser le 

projet, c’est ce que nous verrons dans le troisième chapitre. 
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III.1Introduction 

Plusieurs techniques ont été proposées pour réduire la taille des antennes et créer des fréquences 

de fonctionnement multiples, parmi ces techniques l'incorporation de fentes dans le patch 

rayonnant de l'antenne. Ces fentes modifient le diagramme de rayonnement de l'antenne [21, 22]. 

Le fonctionnement multibande peut être obtenu en utilisant plusieurs antennes, mais le problème 

du couplage dégrade les performances des antennes. De plus, l'utilisation de plusieurs antennes 

augmente la complexité et le coût du dispositif. Il est bien connu que l'efficacité fournie 

lorsqu'une antenne résonne dans plusieurs fréquences est supérieure à l'efficacité de l'utilisation 

d'une antenne pour chaque bande de fréquences. 

La modification de la géométrie de l'antenne, de manière à ce qu'elle puisse être exploitée pour 

les communications sans fil multibandes, est une solution alternative. Dans ce chapitre , nous 

proposons d'incorporer des fentes dans le patch rayonnant d'une antenne patch microstrip conçue 

pour un fonctionnement à 5,5 GHz à l'aide du logiciel HFSS. L'objectif est de concevoir une 

antenne de taille miniature avec trois bandes de fréquence. Les position et les dimensions des 

fentes affectent les fréquences de fonctionnement de l'antenne, c'est pourquoi une analyse 

paramétrique est menée pour atteindre les objectifs requis. 

En effet, une technique d'optimisation, en utilisant un algorithme Matlab est exploitée pour 

sélectionner la meilleur géométrie de l'antenne qui correspond au meilleur comportement triple 

bandes. 

Ce chapitre est divisé en trois parties: 

 Conception d'une antenne patch rectangulaire conventionnelle à une fréquence de 

résonance de 5.5GHz.  

 Conception d'une antenne triple-bande par l’insertion d’une fente rectangulaire dans 

l’élément rayonnant. 

 Conception d'une antenne triple-bande par la création d’une fente de forme 8 dans 

l’élément rayonnant. 
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III.2 Antenne patch monobande (conventionnelle) 

Afin de créer une configuration d'antenne tri-bande, nous concevons d'abord une antenne patch 

rectangulaire de fréquence 5,5 GHz alimenté par câble coaxial  avec une seule fréquence de 

résonance à l'aide des équations d'antennes patch à microruban données ci-dessous 

La géométrie de l'antenne patch monobande de 5,5 GHz est illustrée sur la Figure III.1. 

 

  

 

 

 

 

 

Figure III.1 : Géométrie de l’antenne monobande de 5.5Ghz. 

Le substrat exploité dans cette étude est Rogers RT Durio 5880 avec une constante diélectrique 

εr= 2.2, une tangente de perte tan δ = 0.0009, une taille de 42×36 mm2 et une hauteur h = 0.62 

mm. La technique d'alimentation par sonde coaxiale est utilisée dans l'antenne conçue. La 

largeur (W) et la longueur (L) du patch sont calculées à l'aide des équations suivantes : 

W  
𝑣0

2 𝑓𝑟
√

2

ℰ𝑟
III.1 

L  Leff  2L                                                                                                                      III.2 

Leff   
𝑣0

2 𝑓𝑟√ℰ𝑒𝑓𝑓 
III.3

L h((ℰ𝑒𝑓𝑓 
+ 0.3)((W/h) + 0.264)))/(ℰ𝑒𝑓𝑓 − 0.258)((W/h) + 0.8))      III.4    

ℰ𝑒𝑓𝑓 = ((ℰ𝑟 + 1)/2) + ((ℰ𝑟 − 1)/2) ∗ (1 + (12 h / W ))−½                                      III.5 

où 

v0 est la vitesse de la lumière en espace libre, fr est la fréquence de résonance centrale, Leff est la 

longueur effective, ΔL est la longueur de frange, et εreff est la constante diélectrique effective. 
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Les paramètres de l'antenne patch monobande de fréquence de foncionnement de 5,5 GHz sont 

illustrés dans le Tableau III.1. 

Paramètre Valeur (mm) 

Longueur du patch  (L) 21.6 

Largeur du patch (W)    17.5 

Longueur du substrat (Lg)     42 

Largeur du substrat (Wg)    36 

Hauteur du substrat (h) 0.62 

Position d'avance X (Xf), position d'avance Y (Yf)     0, 3.4 

Tableau III.1 : Paramètres de l'antenne patch microstrip 5.5GHz 

 Résultats de Simulations 

Dans cette section nous présentons les performances de l’antenne conventionnelle à savoir ; 

coefficient de réflexion S11, VSWR, bande  passante ,diagrammes de rayonnement, et gain. 

Coefficient de réflexion (S11) : 

Le coefficient de réflexion met en évidence l’absorption de l’énergie par l’antenne. Les 

discontinuités présentées par l’antenne peuvent être caractérisées par le coefficient de réflexion, 

Ce paramètre permet de caractériser l’adaptation de l’antenne.  

Le coefficient de réflexion imposé selon les normes doit être inférieur à -10dB, et il caractérise le 

taux de réflexion des ondes stationnaire sur la structure.  
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Figure III.2 : Coefficient de réflexion S11(dB) à bande unique de 5,5 GHz 

Figure III.2 représente le coefficient de réflexion S11 en fonction de la fréquence de l’antenne 

conventionnelle de 5.5 GHz. D’après cette figure nous remarquons que le paramètre S11 a 

diminué jusqu'à la valeur de -12.30 dB (<-10 dB) 

La bande passante à -10dB est : 

BP=40MHz (f1 =5.49 GHz, f2=5.53 GHz) 

Rapport d'onde stationnaire (VSWR) : 

Le Rapport d’Onde Stationnaire (en anglais : Voltage Standing Wave Ratio) traduit l’adaptation 

ou la désadaptation d’impédance entre la ligne d’alimentation (câble coaxial) et l’antenne. Ce 

rapport prend des valeurs entre 1 et l’infini. En pratique, une bonne adaptation est réalisée 

lorsque le taux d’onde stationnaire est compris entre 1 et 2. 
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Figure III .3: Rapport d'onde stationnaire (VSWR) à bande unique de 5,5 GHz. 

Figure III.3 représente le VSWR dans la gamme de fonctionnement de l’antenne étudiée. 

D’après cette figure, nous remarquons que le taux d’ondes stationnaires est égale 1.64 (inférieure 

à 2) pour la fréquence de fonctionnement (5.5GHz) donc l'antenne est bien adaptée.  

Diagramme de rayonnement (2D et 3D): 

La propriété de rayonnement la plus préoccupante est la distribution spatiale à deux ou à trois 

dimensions (2D ou 3D) de l'énergie rayonnée en fonction de la position de l'observateur le long 

d'un chemin ou d'une surface de rayon constant.  

Le rendement des antennes à polarisation linéaire est habituellement décrit en termes des deux 

plans E et H. Le plan E est défini comme étant le plan contenant le vecteur champ électrique et la 

direction du rayonnement maximal tandis que le plan H est défini comme étant le plan contenant 

le vecteur champ magnétique et la direction du rayonnement maximal. 
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Figure III.4:Diagramme de rayonnement en 2-D à bande unique de 5,5 GHz. 

. 

Figure III.5: Diagramme de rayonnement en 3-D à bande unique de 5,5 GHz. 

 

Les Figures III.4 et III.5 indiquent les diagrammes de rayonnement en 2-D et en 3-D dans les 

plans phi = 0° (E-Plan) et phi =90° (H-Plan), respectivement pour une fréquence de résonance 

5.5GHz .Ces diagrammes nous donne un gain maximal égal à 7.0 dB. On remarque que le 

rayonnement dans le plan H est omnidirectionnel, alors qu’il presque omnidirectionnel dans le 
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plan E. 

Les résultats peuvent être résumés dans le tableau suivant : 

Fréquence de 

résonance 

(GHz) 

Coefficient de 

réflexion 𝑆11 

(dB) 

Bande 

passante 

(MHz) 

Taux d’onde 

stationnaire 

VSWR 

Gain 

(dB) 

Domaine 

d’utilisation 

 

5.5 -12.30 40 1.64 7.0 bande WI-FI 

Tableau III.2: Résultats d’antenne conventionnelle. 

III.2.1 Antenne patch tri-bande à fente rectangulaire 

La géométrie de l'antenne monobande (conventionnelle) trouvée ci-dessus est modifiée pour 

créer trois bandes de fréquences. Dans cette section une fente de forme rectangulaire est insérée 

dans l’élément de l'antenne monobande. 

La géométrie de l'antenne tri-bande à fente rectangulaire est illustrée à la Figure III.6. 

 

 

 

 

 

 

 

 

 

 

 

Figure III.6: Géométrie de l'antenne tri-bande à une fente rectangle. 

Une fentes est découpée dans la zone du patch rayonnant afin de créer simultanément trois 

fréquences de fonctionnement différentes dans l'antenne conçue. Les dimensions de la fente ainsi 

que leur position affectent les fréquences de résonance de l'antenne conçue. Plusieurs 

conceptions sont étudiées afin de créer trois bandes de fréquences. Les dimensions et les 

positions de la fente sont mentionnés dans le Tableau III.3.  

 

Xslot

1 Yslot1 
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Position du slot (cm) Nom de variable 
Intervalle pour les variables 

(cm) 
Le pas (cm) 

X:-1.2, 

Y:-0.49 

Xslot1 0.1≤ Xslot1≤0.9 0.1 

Yslot1 0.1≤ Yslot1≤0.9 0.1 

Tableau III.3: Plage de variation de slot rectangulaire 

Une analyse paramétrique est utilisée pour créer trois bandes de fréquences , cette étude est très 

importante car elle permet de mieux appréhender l'influence de changement la taille de la fente 

sur les performances de l'antenne proposée.  

Figure III.7: Coefficient de réflexion S 11 avec variation de dimensions de la fente rectangulaire  

 

La Figure III.7 représente la variation du coefficient S11, pour différentes valeur de Xslot1 et 

Yslot1(la longueur et la largeur de la fente rectangulaire) en fonction de fréquence. 

Pour choisir les paramètres optimales de l'antenne nous avons modifiés les dimensions de la 

fente rectangulaire comme illustrer dans le Tableau III.3 ce qui donne 201 combinaisons 

possibles implique 201 courbes de S11. Le choix manuel de la meilleure géométrie est 

impossible, c'est pour cette raison que nous avons opté à l'optimisation en utilisant un 

programme Matlab. 
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Après avoir chargé la base de données, nous ballions les 201 courbes de S11 qui constituent cette 

base.  

Condition_1 : On cherche les courbes qui coupe la droite de -10dB en six points, cette condition 

est utilisée pour trouver les géométries des antennes qui ont un comportement triple bande (voir 

Figure III.8). Si la courbe coupe -10dB en 2 ou 4 points par exemple le comportement est mono 

ou double bandes respectivement. 

Condition_2 : est utilisée pour optimiser les valeurs de coefficient de réflexion. On cherche un 

comportement triple bandes dont les valeurs de S11 pour les trois bandes sont inférieurs à -12dB. 

En suite, on chercher les valeurs de Xslot1 et Yslot1 qui correspondent au meilleur 

comportement triple bandes  

Début 

Entrée : lire la base de donnée  

Pour i vari de 1 à 201 faire 

Si S11(i) coupe la droite de -10dB en six points 

Affecter à Condition_1 la valeur 6 

Si les valeurs des trois minima sont  < -12 

Affecter à Condition_2 la valeur 3 

Fin de si 

Fin de si 

Si Condition_1=6 & Condition_2=3 

Affecter à x les valeurs de i qui satisfaits Condition_1=6 &Condition_2=3 

Fin de si 

Fin de pour 

Sortie :  

Tracer la courbe de S11(x) 

Trouver Xslot1(x) et Yslot1(x) 
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La meilleure courbe (meilleur S11) satisfait les deux conditions précédentes (meilleur 

comportement triple bandes) est représentée par la Figure III.8 dont les valeurs de Xslot1= 

Yslot1=0.9 cm sont sélectionnées. 

Figure III.8 : Coefficient de réflexion (S11) en fonction de la fréquence. 

L’antenne optimisée présente les trois bandes de fréquences suivantes:  

 𝑓1 = 4.31 GHz (valeur de 𝑆11  − 15.25𝑑𝐵), et une bande passante de 4.34-

4.299=50MHz. 

 𝑓2 = 7.85 GHz (valeur de 𝑆11  − 17.97𝑑𝐵), et une bande passante de 7.90-

7.82=80MHz. 

 𝑓3 = 10.17 GHz (valeur de 𝑆11  − 30.33𝑑𝐵), et une bande passante de 10.25-

10.11=140 MHz. 

On remarque que la fréquence f3 présente la meilleur valeur du coefficient de réflexion (valeur 

minimale). Pour les trois fréquences de fonctionnement des bandes passantes acceptables sont 

trouvées. 
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 Rapport d’onde stationnaire  

Figure III .9: Variation du rapport d'onde stationnaire en fonction de la fréquence. 

La Figure III .9 montre le diagramme du VSWR en fonction de fréquence pour l'antenne triple 

bande optimisée. Cette dernière présentes des valeurs de VSWR de 1.41, 1.28 et 1.06 aux 

fréquences centrales de 4.31 GHz, 4,49 GHz et 10.17 GHz, respectivement. Les résultats obtenus 

démontrent que l'antenne résonne dans la limite du VSWR qui se situe entre 1 et 2 ce qui indique 

qu'une bonne adaptation d'impédance entre la ligne d'alimentation de l'antenne et le patch 

rayonnant est obtenue. 

 Diagramme de rayonnement 

Les Figures III.10, III.11 et III.12 représentent le diagramme de rayonnement simulé dans le 

plan E (phi =0) et dans le plan H (phi =90°) pour différentes fréquences (4.3166 GHZ, 7.8543 

GHZ et 10.1759GHz). 
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 Pour F1= 4.31GHz: 

 

(a) 

 

(b) 

Figure III.10 : Diagramme de rayonnement à la fréquence 4.3166GHz(a)2D (b) 3D. 
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 Pour F2= 7.85 GHz: 

 

(a) 

(b) 

Figure III .11 : Diagramme de rayonnement à la fréquence 7.85 GHz : (a) 2D,  (b) 3D. 
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 Pour F3= 10.17 GHz: 

 

(a) 

(b) 

Figure III.12 : Diagramme de rayonnement à la fréquence 10.17 GHz : (a) 2D, (b) 3D. 

D’après les Figure III .10, III .11 et III.12, on remarque que le rayonnement est concentré dans 

un lobe principal orienté vers la verticale du patch (θ = 0°). L’antenne présente des valeurs de 

gain très acceptables de 5.2 dB, 6.4 dB et 8.5 dB pour les trois fréquence de fonctionnement 4.31 

GHz, 7.85 GHz et 10.17 GHz respectivement. 

Les performances de l’antenne triple bande avec une fente rectangulaire sont résumées dans le 
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tableau suivant : 

Fréquence de 

résonance (GHz) 

coefficient de 

réflexion 𝑆11 (dB) 

bande 

passante 

(MHz) 

taux d’onde 

stationnaire VSWR 

(dB) 

Gain 

(dB) 

4.31 − 15.25 50 1.41 5.2 

7.85 − 17.97 80 1.28 6.4 

10.17 − 30.33 140 1.06 8.5 

Tableaux III.4: Performances de l’antennes triple bande avec une fente rectangulaire 

 

L’utilisation de chaque fréquence est illustrée dans le tableau suivant : 

Bande de fréquence 

(GHz) 
Nom Service  satellitaires 

4.31 ϵ [4 à 8 GHz] Bande C Diffusion de radio, données, TV mobiles. 

7.85 ϵ [4 à 8 GHz] Bande C Diffusion de radio, données, TV mobiles. 

10.17 ϵ [8 à 12 GHz] Bande X 
Utilisée pour les radars, les communications par satellite et 

réseaux informatiques sans fil. 

Tableau III.5: Bandes de fréquences et utilisations. 

 

III.2.2 Antenne patch tri-bande à fente de forme 8 : 

Dans cette section, nous présentons l’étude et la conception une autre antenne Triple bandes, 

cette fois la géométrie de l'antenne monobande (conventionnelle) est modifiée pour créer trois 

bandes de fréquences. Une fente de forme 8 est insérée dans l’élément rayonnant de l'antenne 

monobande. 

La géométrie de l'antenne tri-bande à fente de forme 8 est illustrée à la Figure III.13. 
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Figure III.13: Antenne Patch rectangulaire alimenté par câble coaxial avec  une fente en forme 

de numéro 8. 

Plusieurs fentes sont découpées dans l’élément rayonnant de l’antenne pour de créer 

simultanément trois fréquences de fonctionnement différentes dans l'antenne conçue. Les 

dimensions des fentes ainsi que leurs positions affectent les fréquences de résonance de l'antenne 

conçue. En effet, une analyse paramétrique est utilisée afin de créer trois bandes de fréquences 

dans l’antenne conçue. Plusieurs conceptions sont étudiées, les dimensions et les positions des 

fentes sont mentionnés dans le Tableau III.6.  
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Fente 
position du Fente (X, Y, 

Z) (cm) 

Nom de 

variable 
Valeurs des variables (cm) 

le pas 

(cm) 

S1 -0.22 ,0 ,0.062 
xslot1 0.02≤XSLOT1≤0.1 0.15 

yslot1 0.8≤YSLOT1≤0.8 0.5 

S2 -0.31 ,0.8 ,0.062 
xslot_1 0.1≤xslot_1≤0.91 0.5 

yslot_1 -1.2≤yslot_1≤-0.2 0.75 

S3 -0.38 ,0 ,0.062 / 
X= 0.91 

Y =-0.2 
/ 

S4 -1 ,0.8 ,0.062 / 
X = 0.91 

Y = -0.2 
/ 

S5 -1 ,0 ,0.062 / 
X = 0.91 

Y= 0.2 
/ 

S6 -0.85 ,0 ,0.062 / 
X = -0.15 

Y= 0.6 
/ 

S7 0.53,-0.1 ,0.062 / 
X = 0.07 

Y= 0.8 
/ 

Tableau III.6: Plage de variation des fentes 

 

 

Figure III.14 : Coefficient de réflexion S 11 avec variation de dimensions des fentes. 
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La Figure III.14 représente la variation du coefficient S11 en fonction des dimensions des fentes. 

Un choix manuel (à l'œil nu) de la meilleure géométrie est pratiquement impossible, c’est pour 

cette raison que nous avons opté à l’optimisation en utilisant un programme Matlab. Ce dernier 

est illustré dans section précédente. 

Après optimisation, les dimensions des fentes correspondent au meilleur comportement triple 

bandes  sont représentées dans le Tableau III.7. 

Fentes Valeurs des variables (cm) 

S1 
xslot1=0.1 

yslot1=-0.8 

S2 
xslot_1=0.1 

yslot_1=-0.2 

S3,S4 et S5 
DX : 0.91 

DY :-0.2 

S6 
DX : -0.15 

DY : 0.6 

S7 
DX : 0.07 

DY : 0.8 

Tableau III.7: Dimensions  de fentes après optimisation. 

 

La Figure III.15 représente le coefficient de réflexion (S11) en fonction de la fréquence  de 

l’antenne triple bandes optimisée avec une fente en forme de numéro 8. 

 

Figure III.15 : Coefficient de réflexion (S11) en fonction de la fréquence avec une fente en 

forme de numéro 8. 
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L’antenne triple bandes proposée présente les trois bandes de fréquences suivantes:  

 𝑓1 = 3.26 (bande S) (valeur de 𝑆11  − 23.35 𝑑𝐵), et une bande passante de 3.29-

3.23=60 MHz. 

 𝑓2 = 7.87 𝐺𝐻𝑧 (bande C) (valeur de 𝑆11  − 14.81𝑑𝐵), et une bande passante de 

7.90-7.86=40 MHz. 

 𝑓3 = 8.73 GHz (bande X) (valeur de 𝑆11  − 13.31𝑑𝐵), et une bande passante de 

8.76-8.71=50 MHz. 

Il est à noter que la fréquence f1 correspond au meilleur coefficient de réflexion (valeur 

minimale). Pour les trois fréquences de fonctionnement des bandes passantes acceptables sont 

trouvées. 

 Rapport d’onde stationnaire 

Le rapport d’onde stationnaire en fonction de la fréquence est présenté dans la Figure III. 16.  

Figure III.16: VSWR en fonction de fréquence. 

La Figure III.16 présente la courbe du taux d’onde stationnaire en fonction de fréquence pour 

l'antenne triple bande proposée. Cette antenne présente des VSWR 1.14, 1.44 et 1.55 pour les 

fréquences de résonances de 3.26 GHz, 7.85 GHz et 8.73 GHz, respectivement. Les résultats 

obtenus démontrent que l'antenne résonne dans la limite du VSWR qui se situe entre 1 et 2 ce qui 

indique qu'une bonne adaptation d'impédance entre la ligne d'alimentation de l'antenne et le 

patch rayonnant est obtenue. 
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 Diagramme de rayonnement  

Les diagrammes de rayonnement dans les deux plans E (phi =0°) et H (phi =90°), pour les trois 

fréquences de fonctionnement, sont représentés dans les figures III.17, III.18 et III.19. 

 Pour F= 3.26 GHz : 

 

 

(a) 

 

(b) 

Figure III.17 : Diagramme de rayonnement à la fréquence 3.26GHz : (a)2D, (b) 3D. 
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 Pour F= 7.85 GHz : 

 

(a) 

 

(b)  

Figure III.18 : Diagramme de rayonnement à la fréquence 7.85 GHz : (a)2D, (b) 3D. 
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 Pour F= 8.73 GHz : 

 

(a) 

 

(b) 

Figure III.19 : Diagramme de rayonnement à la fréquence 8.73 GHz(a)2D (b) 3D. 

D’après les Figure III .17, III .18 et III.19, on constate que rayonnement est concentré dans un 

lobe principal orienté vers la verticale du patch (θ = 0°). Des gains très acceptables de 2.4 dB, 6 

dB et 7.8 dB sont trouvés avec cette antenne pour les trois fréquence de résonances  3.26 GHz, 

7.85 GHz et 8.73 GHz, respectivement. 
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Les performances de l’antennes triple bande avec une fente de forme 8 sont résumées dans le 

tableau suivant : 

Fréquence de 

résonance (GHz) 

Coefficient de 

réflexion 𝑆11 (dB) 

Bande 

passante 

(MHz) 

Taux d’onde 

stationnaire VSWR 

(dB) 

Gain 

(dB) 

 

3.26 − 23.35 60 1.14 2.4 

7.87 − 14.81 40 1.44 6.0 

8.73 − 13.31 50 1.55 7.8 

Tableaux III.8: Performances de l’antenne triple bande avec une fente de forme 8. 

 

L’utilisation de chaque fréquence est illustrée dans le tableau suivant : 

Bande de fréquence 

(GHz) 
Nom Services 

3.26 ϵ [2 à 4 GHz] Bande S Diffusion de TV, radio, données 

7.87 ϵ [4 à 8 GHz] Bande C Diffusion de radio, données, TV mobiles 

8.73 ϵ [8 à 12 GHz] Bande X 
Utilisée pour les radars, les communications par satellite et 

réseaux informatiques sans fil 

Tableau III.9: Bandes de fréquences et utilisations. 

 

III.3 Etude comparative 

Les performances des deux antennes triples bandes proposée dans ce mémoire ainsi que les 

performances de l’antenne conventionnelle sont illustrées dans le Tableau III.10. 

En utilisant une antenne conventionnelle qui fonctionne à une fréquence de résonance de 

5.5GHz, nous avons réussi de concevoir deux antennes triple bandes. 

Il est à noter que l’antenne avec une fente rectangulaire présente un gain et une bande passante 

relativement élevé par rapport à l’antenne avec fente de forme 8. Mais cette dernière travail sur 

trois type de bandes différentes (S, C et X) par rapport à l’antenne avec fente rectangulaire qui 

opère dans deux type de bandes (C et X). 

Par rapport à l’antenne conventionnelle, les deux antennes proposées présentent une amélioration 

significative en terme de coefficient de réflexion, bande passante et adaptation (VSWR). 
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Fréquence 

de 

résonance 

(GHz) 

Coefficient 

de 

réflexion 

𝑆11 (dB) 

Bande 

passante 

(MHz) 

taux d’onde 

stationnaire 

VSWR 

(dB) 

Gain 

(dB) 
Utilisations 

Antenne 

conventionnelle 
5.5 −12.30 40 1.64 7.0 WI-FI 

Antenne avec 

fente 

rectangulaire 

4.31 − 15.25 50 1.41 5.2 Bande C 

7.85 − 17.97 80 1.28 6.4 Bande C 

10.17 − 30.33 140 1.06 8.5 Bande X 

Antenne avec 

fente de forme 

8 

3.26 − 23.35 60 1.14 2.4 Bande S 

7.87 − 14.81 40 1.44 6.0 Bande C 

8.73 − 13.31 50 1.55 7.8 Bande X 

Tableau III.10: Etude comparative des trois antennes 

 

III.4 Conclusion 

Dans ce chapitre et afin de créer une configuration d'antenne tri-bande, nous avons conçu d'abord 

une antenne patch rectangulaire alimenté par câble coaxial avec une seule fréquence de 

résonance à l'aide des équations d'antennes patch à microruban. Ensuite, la géométrie de 

l'antenne monobande (conventionnelle) est modifiée pour créer trois bandes de fréquences.  

Deux géométries de fentes sont insérées dans l’élément rayonnant de l'antenne monobande, une 

fente rectangulaire et une fente de forme 8. Les positions et les dimensions des fentes sont 

déterminées à l'aide d'une analyse paramétrique.  

Les deux antennes proposées présentent des bonnes performances à savoir ; un gain élevé, une 

bande passante acceptable et une bonne adaptation. Les bandes de fonctionnement offrent de 

nombreuses applications potentielles dans les communications sans fil d'aujourd'hui, en 

particulier la transmission des données dans les radars, les communications par satellite et les 

réseaux informatiques sans fil. 

De plus, une technique d’optimisation est proposée, cette dernière nous a permit de sélectionner 

les meilleurs géométries d’antennes qui correspondent au meilleurs comportements triple bandes.  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Conclusion générale 
 

                                                                                        80 
 

Conclusion générale 

Les appareils sans fil faisant désormais partie intégrante de la vie de la plupart des 

gens, l'intégration de technologies telles que WLAN, WiMAX, Bluetooth, etc. dans 

un seul appareil est une solution parfaite pour améliorer les avancées commerciales. 

Bien qu'une antenne large bande ou ultra-large bande [3] puisse être une solution 

possible, les systèmes équipés de telles antennes ont besoin de filtres supplémentaires 

pour éliminer les interférences des systèmes de communication fonctionnant dans les 

bandes voisines. Dans un tel scénario, une antenne multibande [22], [23] s'avère être 

une solution rentable car elle élimine les filtres en supprimant les bandes inutiles et 

permet ainsi d'intégrer plusieurs normes de communication sans fil dans un seul 

système, améliorant ainsi la portabilité d'un terminal sans fil. 

L'antenne planaire, en raison de ses caractéristiques attrayantes, notamment son profil 

et son poids réduits, son faible coût et sa structure polyvalente permettant un mode de 

résonance double ou multiple et des caractéristiques de rayonnement souhaitables, est 

devenue un candidat privilégié parmi les autres prototypes d'antennes. Cependant, les 

concepteurs d'antennes sont confrontés à un grand défi lorsqu'il s'agit de réduire la 

taille d'une antenne tout en augmentant le nombre de bandes de fréquences 

opérationnelles. 

Dans ce mémoire nous proposons deux configurations d'antenne triple bandes. La 

stratégie est d’étudier l’insertion des fentes dans l’élément rayonnant d'une antenne 

conventionnelle (une seule bande de fréquence) afin d'obtenir une antenne tri-bande. 

Comme première étape nous avons présenté la conception d'antenne patch 

rectangulaire (conventionnelle) alimentée par une ligne coaxiale qui rayonne à une 

fréquence de résonance de 5.5 GHz simulé à l'aide du logiciel de Simulation 

électromagnétique HFSS. 

Ensuite, nous avons incorporé deux géométries de fentes, une fente rectangulaire puis 

une fente de forme 8. Les positions et les dimensions des fentes sont déterminées à 

l'aide d'une analyse paramétrique pour atteindre les objectifs requis. En effet, une 

technique d'optimisation, en utilisant un algorithme Matlab, est exploitée pour 

sélectionner la meilleur géométrie de l'antenne qui corresponde au meilleur 

comportement triple bandes. 
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L'antenne proposée avec une fente rectangulaire de taille miniature (42×36mm2) offre 

un gain directif de 5.2 dB, 6.4 dB et 8.5 dB aux fréquences de résonance de 4.31 GHz, 

7.85 GHz et 10.17 GHz, respectivement. Les rapports perte de retour/onde 

stationnaire correspondants (S11/VSWR) sont de -15.25 dB/1.41, -17.85dB/1.28, et -

30.33dB/1.06 pour les trois bandes de fréquences citées précédemment.  

Le deuxième antenne proposée avec une fente de forme 8 offre un gain directif de 2.4 

dB, 6.0 dB et 7.8 dB aux fréquences de résonance de 3.26 GHz, 7.87 GHz et 8.73 

GHz, respectivement. Les rapports perte de retour/onde stationnaire correspondants 

(S11/VSWR) sont de -23.35dB/1.14, -14.81dB/1.44, et -13.31dB/1.55 pour les trois 

bandes de fréquences citées précédemment.  

D'après les résultats obtenus, on peut dire que l'incorporation de fentes dans le patch 

rayonnant offre une solution prometteuse pour la miniaturisation des antennes ainsi 

que pour la création de plusieurs bandes de fréquences opérationnelles. Les antennes 

proposées sont donc adaptées à la couverture de plusieurs bandes de communication 

sans fil utiles (bande S, bande C et bande X) telles que les applications WiMAX et 

WLAN. 

Dans le cadre de travaux futurs, nous avons l'intention d'utiliser des plans de masses 

partiels dans la conception des antennes proposées afin d'améliorer les bandes 

passantes. 
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	HFSS est un logiciel de modélisation électromagnétique et d'analyse des circuits passifs et des structures tridimensionnels. Il aide le concepteur à observer et analyser les diverses propriétés électromagnétiques de la structure tels que les caractéri...
	II.2 Présentation du logiciel Ansoft HFSS
	II.3 avantages et inconvénients du HFSS
	Les avantages et les inconvénients de ce logiciel sont:
	 Complexité de travail et de création des structures (plusieurs détails de conception).
	 La nécessité d’avoir maitrisé l’utilisation du logiciel, avant d’aborder le projet, parce qu’on est obligé de se servir des opérations booléennes parfois, pour dessiner des surfaces ou formes n’ayant pas une forme géométrique bien définie.
	 En plus on doit faire attention aux frontières (Boundaries), il ne faut pas avoir des conflits entre une surface de radiation par exemple et une surface conductrice.
	 La simulation pourra prendre une durée de plusieurs heures jusqu’aux plusieurs jours parfois, surtout si le projet à simuler est d’un volume relativement grand, et présente beaucoup de détails. [19]
	II.5 Comment ouvrir un nouveau projet
	II.6 Sauvegarder le projet
	II.9 Exemple d’étapes de simulation d’antenne Patch rectangulaire alimenté Par câble coaxial
	Figure II.12: Sélection de type de solution.
	Figure II.13 : Sélection des unités.
	II.9.1 Créer le substrat
	Draw>Box ou clique sur
	Pour dessiner le substrat, cliquer dans la barre4 d’outils. Dessiner alors une boîte.
	En utilisant les surfaces d'entrées du même rang, entrer la position et dimension de Box  comme montré dans la figure suivante :
	Figure II.14 : Position et dimensions de Box.
	Figure II.16 : Substrat diélectrique.
	Figure II.17 : Plan de mass (inf_gnd).
	FigureII.18:Perfect E
	HFSS>Boundaries>Assign>Perfect E
	La radiation est illustrée ci-dessous :
	II.9.5 Créer le Patch
	En utilisant les champs de saisie des coordonnées, entrez la position du rectangle X: -1.08, Y: -0.875 Z: 0.062, appuyez sur la touche Entrée.
	En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle: dx : 2.16, dy: 1.75, dZ: 0.0, appuyez sur la touche Entrée.
	Figure II.22 : Assignement de la condition "Conducteur parfait" pour le patch.
	II.9.12 Créer l’Air
	Cliquez sur Draw>Box
	En utilisant les champs de saisie des coordonnées, entrez la position de la boîte X: -2.1, Y: -1.8, Z: 0.0, appuyez sur la touche Entrée.
	À l'aide des champs de saisie des coordonnées, entrez le coin opposé de la boîte DX :4.2, dy: 3.6, dZ: 1.062.
	Définir le nom: air_box.
	Figure II.27 : Boitier d’air.
	II.9.13 Assigner les conditions aux limites (Radiation Boundary)
	Cliquez sur Edit>Select>Faces
	Sélectionner graphiquement toutes les faces de l'objet, sauf la face à Z = 0.0cm (le fond).
	Pour créer une limite de rayonnement HFSS>Boundaries>Assign >Radiation
	Figure II.28 : Assignement des frontières.
	Figure II.29: Configuration du rayonnement.
	II.9.15 Créer une installation d'analyse (analysis setup)
	Choisir „‟ Add Solution Setup„ dans le menu HFSS >Analysis Setup >Add    Solution Setup.
	Figure II.30 : Solution d’analyse (fréquentielle).
	II.9.16 Ajouter le champ de fréquence (Add Frequency Sweep)
	Figure II.31: Plage de fréquence et type d’analyse.
	II.9.17  Analyse
	Pour valider le modèle:
	II.9 .18 Créer les rapports
	II .10 Conclusion
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